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WelcomeWelcome
Welcome to the 2003 IEEE International Geoscience and Remote
Sensing Symposium  on CD-ROM. This disc is designed so that you
may locate papers by session or author, as well as with full text
search of title and body.

Papers originated as electronic files. The papers were converted to
Adobe Acrobat PDF file format for cross-platform access. The viewing
quality will vary with the size and quality of fonts used. Even though
the viewing quality on your monitor may vary, all papers print clearly.

Be sure to read the “Getting Star ted” section for useful
recommendations on how to use this electronic guide.

Thank you and enjoy!
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Copyright and Reprint Permission

Abstracting is permitted with credit to the source. Libraries are
permitted to photocopy beyond the limits of U. S. Copyright law for
private use of patrons those articles in this volume that carry a code
at the bottom of the first page, provided the per-copy fee indicated
in the code is paid through the Copyright Clearance Center, 222
Rosewood Drive, Danvers, MA, 01923. For other copying, reprint or
republication permission, write to:

IEEE Copyrights Manager, IEEE Operations Center, 445 Hoes
Lane, P. O. Box 1331, Piscataway, NJ, 08855-1331.

Copyright © 2003 by the Institute of Electrical and Electronics
Engineers, Inc. All rights reserved.

IEEE Catalog Number: 03CH37477C (CD-ROM)
IEEE Catalog Number: 03CH37477 (Softbound)

Library of Congress Number: 2003104493

ISBN Softbound: 0-7803-7929-2
ISBN CD-ROM: 0-7803-7930-6
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Additional copies of the Proceedings are available from the following
source:

IEEE Operations Center
P.O. Box 1331
445 Hoes Lane
Piscataway NJ 08855-1331 USA

1-800-678-IEEE
1-732-981-1393
1-732-981-9667 (FAX)
email: customer.services@ieee.org
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Trademarks

Adobe, the Adobe logo, Acrobat and the Acrobat logo are trademarks
of Adobe Systems Incorporated or its subsidiaries and may be
registered in certain jurisdictions. Macintosh is a registered
trademark of Apple Computer, Inc. HP is a registered trademark and
HP-UX is a trademark of Hewlett-Packard Company. Motif is a
trademark of Open Software Foundation, Inc. Solaris is a registered
trademark of Sun Microsystems, Inc., Sun and OpenWindows are
trademarks of Sun Microsystems, Inc. SPARC is a registered
trademark of SPARC International, Inc. SPARCstation is a registered
trademark of SPARC International, Inc., licensed exclusively to Sun
Microsystems, Inc. and is based upon an architecture developed by
Sun Microsystems, Inc. UNIX is a registered trademark in the United
States and other countries, licensed exclusively through X/Open
Company, Ltd. Windows is a trademark of Microsoft Corporation.  X
Window System is a trademark of the Massachusetts Institute of
Technology. I386, 486 and Pentium are trademarks of Intel
Corporation.  All other products or name brands are trademarks of
their respective holders.
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ORIENTATION

This Electronic Guide file contains hypertext links  to individual article
files.  Links are represented by colored text (e.g., a name or title);
clicking on the text activates the link.

Before you start browsing and using the information on this CD-
ROM, you will need to install Adobe Acrobat Reader + Search 5.0.
If you already have Acrobat Reader installed on your system, make
sure it is version 4.0 or higher and includes the Search  plug-in.

To install, click on “ README.TXT” which contains additional
information.

In many instances, we refer to the “menu bar” and “tool bar”, shown
here for reference.

   menu bar:

      tool bar:

Be sure to read the following on how to achieve the best
performance with this electronic guide.
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In order to take full advantage of the performance capabilities of
this collection, we recommend that you do the following:

1.  To make navigation and searching easier, we strongly
recommend changing the following Acrobat Search
Preferences (found under Edit> Preferences > Search on the
menu bar.) In the dialog box shown for Acrobat Search
Preferences, make the following changes:

A.  Select the “Document Information” option so that Title,
Author, Keywords, and Subject fields are visible when
specifying search criteria.  If for some reason this preference
option is not present on your system, check to see that you

have the Search plug-in installed. The Search icon  will be

present on the Acrobat tool bar if the function is properly
installed. Specifics of the Search function are described later
in this section.
B.  Change “Show first 100 documents” to “Show first 1000
documents”. (Type in “1000” in the field provided.) This allows
the maximum number of hits to be displayed during a search.

These settings will become your new default.

RECOMMENDATIONS FOR OPTIMAL PERFORMANCE
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USING BOOKMARKS

In addition to links, you can navigate through the Electronic Guide
using Bookmarks.  If they are not already visible, choose Window
> Bookmarks from the menu bar or press the “Show/Hide
Navigation Pane” button on the tool bar.  A panel opens on the left
side of the screen displaying Bookmarks in a hierarchy.
Each Bookmark corresponds to a location in the Electronic Guide.
Click on the text in a Bookmark to go to that location.

Entries with lower level Bookmarks show a plus sign (+) when
subordinate Bookmarks are hidden and a negative sign (-) when
subordinate Bookmarks are visible.  To view subordinate
Bookmarks, click on the plus sign (+).  To hide them, click on the
negative sign (-).  Dragging the right margin of the bookmark
panel resizes it. Dragging the Bookmark tab moves the panel to a
different location.
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SELECTING TEXT AND GRAPHICS
To select text or graphics, the appropriate select tool must be
selected. The select tools share the same space on the tool bar.

To see more text selection tools you must click the arrow to the right
of the Text Select Tool. A “flyout” menu will allow you to select the
Column Select Tool.

See the Adobe Acrobat Reader 5.0 Guide (Help > Reader Help) for
more information on these tools.

Text Select Tool Graphic Select Tool
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NAVIGATION BUTTONS

Section Map
The current section is shown at the top of each page. The “path”
to this section is shown at the right.  Clicking these text buttons
moves you to the start of that section.

Next Page
Click to advance to the next page in the section.

Previous Page
Click to go back to the previous page in the section.

(The Page Up and Page Down keys perform the same
functions as the Next and Previous Page buttons.)

Fast Forward Pages
Click to advance (jump) multiple pages in the section.

Fast Back Pages
Click to go back (jump) multiple pages in the section.
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ACROBAT TOOLBAR

Navigation

History

Go to Next View (One Link)
Go to Previous View (One Link)

Go to Last Page
Go Forward One Page
Go Backward One Page
Go to First Page
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Zoom

Zoom Out
Zoom In
Hand Tool

Selection

ACROBAT TOOLBAR

Graphic  Select Tool
Column  Select Tool
Text Select Tool
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ACROBAT TOOLBAR

Page View

Find/Search

Next Highlight (Hit)
Previous Highlight (Hit)
View Search Results
Search
Find

Fit Width
Fit in Window
Actual Size
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PERFORMING A “FIND”
Choosing Find opens a dialog box. Find scans linearly through the
currently open Acrobat file from the cursor forward.  If the Electronic
Guide PDF is open, Find will scan the entire Electronic Guide for
a match to your text.  Type a text string in the field provided, check
the appropriate options and press the “Find” button. Reader then
highlights the first instance of the text string. To look at the next “hit”,
click on the Find icon and press the “Find Again” button in the
Acrobat Find window.

PERFORMING A “SEARCH”
Choosing the “Search” tool bar button or Search menu item (Edit
> Search > Query), opens a dialog box from which you can access
the more powerful full-text search engine (if you installed Acrobat
Reader from this CD-ROM).  Its dialog box is shown on the next
page.

Typing a term in the text box at the top of the Search dialog box and
pressing the “Search” button causes a full-text search of all words
in the body of papers in the collection.  If you have “Document
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Information” active in your Reader preferences, entering a term in
one or more of the fixed fields (Title, Author, Subject or Keywords)
will cause a search for hits in only those fields.
If you are not finding files you think should show in the results list,
Acrobat may not be attached to the correct index file.  To check,
press the “Indexes...” button for a list of available indexes.  If this
collection is not listed, press the “Add...” button and look in the root
directory of the CD-ROM for a file called “index.pdx”.  Click on that
file to add it to the list.

voltage

See the Reader Help (on
Help menu) for more
complete instructions on
selecting appropriate
options,  constructing
boolean queries, etc.
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Monday 

SMOS ❑

ADEOS II ❑

25th Anniversary of the Seasat Launch - Seasat Legacy ❑

Geographic Information Systems ❑

Remote Sensing of Sea Ice ❑

Hyperspectral Processing and Analysis ❑

RADARSAT-1 ❑

Rough Surface Scattering ❑

An Earth Science Vision: Global Understanding of the 
Complexities of Our Planet 

❑

Remote Sensing Applications in Agriculture ❑

PART I: Image Registration and Geocoding;  PART II: 
Optical Stereoscopy and Radargrammetry 

❑

Click on title for a list of papers.
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Tuesday 

Information Extraction from High Resolution SAR Data ❑

Deformation: Earthquakes, Subsidence and Volcanos ❑

Ocean Waves and Winds ❑

Land Use - Land Cover ❑

Sea Ice Information from Newly Multi-Sensor Satellite Data ❑

Hyperspectral Methods ❑

SPOT-5 Part I ❑

Student Prize Paper Competition ❑

NPOESS ❑

Agriculture II ❑

Soil Moisture and Hydrological Modeling ❑

Advances in Polarimetry ❑

Optical Very High Resolution Image Processing ❑

PART I: Educational Techniques in Remote Sensing;  PART 
II: SIBERIA II 

❑

Click on title for a list of papers.
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Instrumentation and Future Technologies ❑

Reconfigurable SAR Systems ❑

Hyperspectral Applications ❑

SPOT-5 Part II ❑

Vegetation Fluorescence ❑

Earth Observing Architectures: Technology Challenges for 
the Coming Generation of Earth Explorers 

❑

Data Archiving and Distribution ❑

First AMSR Science Results ❑

Click on title for a list of papers.
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Wednesday 

Pol- and Pol-INSAR Data Processing I ❑

WINDSAT ❑

Optical Image Processing ❑

Mine and Target Detection ❑

Bistatic Radar Remote Sensing ❑

Registration and Combination of Imagery ❑

In-Flight Ocean Altimetry ❑

Snow Cover ❑

EOS Terra and Aqua MODIS Validated Science Results ❑

Spaceborne Remote Sensing of Precipitation ❑

Soil Moisture Retrieval ❑

Polarimetric and Interferometric Data Processing ❑

Near Surface Ocean Processes ❑

Vegetation and Forest Analysis ❑

Click on title for a list of papers.
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Use of Remote Sensing and GIS Technologies for Planning, 
Management, Monitoring and Forecasting in Africa 

❑

Military Applications of Remote Sensing ❑

Data Fusion Applications ❑

Present and Future Altimeters ❑

Electromagnetics and GPS ❑

ENVISAT/ASAR ❑

Techniques for Remote Sensing of Precipitation ❑

Hydrological Applications ❑

Click on title for a list of papers.
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Thursday 

Interferometric SAR Processing ❑

Advanced Microwave Radiometer Techniques ❑

Active Sensing of Ocean Winds ❑

Aerosols: Characterization and Sensing ❑

Environmental Hazards ❑

RADARSAT-2 and TERRASAR ❑

Future NASA Earth Observing System Missions ❑

Volume and Subsurface Scattering ❑

ENVISAT / Atmospheric Chemistry ❑

Change Detection Techniques ❑

Active Microwave Soil Moisture and Roughness ❑

Polarimetric Interferometry and Applications ❑

SAR and Bistatic SAR Processing ❑

Remote Sensing Potential to Support Multi-National 
Environmental Conventions 

❑

Click on title for a list of papers.
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Atmospheric Remote Sensing ❑

Spaceborne Lidar: CALIPSO and GLAS ❑

Disaster and Hazards ❑

Geological Process Monitoring ❑

The Dynamic Landscape ❑

ENVISAT / MERIS-AATSR ❑

Ice Sheets and Glaciers ❑

Estimating Vegetation Parameters Using SAR ❑

Click on title for a list of papers.
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Friday 

PART I: Pol- and Pol-INSAR Data Processing II;  PART II: 
SAR Data Processing and Filtering 

❑

Soil and Vegetation Biophysical Properties ❑

TRMM & GPM I ❑

Urban Planning and Environmental Monitoring ❑

PART I: Frequency Allocations in Remote Sensing;  PART 
II: Lidar Remote Sensing 

❑

Hyperspectral Applications and Methods II ❑

Classification and Segmentation I ❑

Compression Techniques Applicable to Multidimensional 
Remote Sensing Data 

❑

Advanced Land Observing Satellite ❑

Arid Zones and Archaeology ❑

PART I: MODIS Applications;  PART II: Future Missions ❑

Ocean Waves and Dynamics ❑

Click on title for a list of papers.
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Forest Biomass Monitoring ❑

TRMM & GPM II ❑

Urban Planning and Management ❑

SAR Processing and Statistical Modeling ❑

PART I: New Hyperspectral Instruments and Techniques;  
PART II: Data Compression 

❑

Classification and Segmentation II ❑

Information Processing and Extraction ❑

PART I: Environmental Degradation and Pollution;  PART II: 
Stable Points Interferometry 

❑

Coastal Environment ❑

Novel Radar and Radiometry Concepts and Technology ❑

Click on title for a list of papers.
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Interactive Sessions 

A01 - Aerosols ❑

A02 - Agriculture ❑

A03 - Air-Sea Interactions ❑

A04 - Archeology ❑

A05 - Arid & Semi-Arid Lands ❑

A06 - Atmosphere ❑

A07 - Cartography & Topography ❑

A08 - Climate ❑

A09 - Clouds & Precipitation ❑

A10 - Coastal, Coral, Lake & Riverside Environments ❑

A11 - Crustal Movements, Earthquake & Volcano ❑

A12 - Disaster & Hazards ❑

A13 - Environmental Degradation & Pollution ❑

A14 - Fires & Fire Danger Monitoring ❑

Click on title for a list of papers.
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A15 - Floods ❑

A16 - Forest Classification ❑

A17 - Forest Monitoring ❑

A18 - Geological Process Monitoring ❑

A19 - Glaciers & Ice Sheets ❑

A20 - Hydrology ❑

A21 - Land Cover ❑

A22 - Military Applications ❑

A23 - Mine & Target Detection ❑

A24 - Mineral Resource Mapping ❑

A25 - Ocean Surface & Sub-Surface Processes ❑

A26 - Ocean Waves & Winds ❑

A27 - Ocean Pollution Detection & Monitoring ❑

A28 - Planetary Studies ❑

A29 - Remote Sensing of the Mediterranean Basin ❑

A30 - Salinity ❑

Click on title for a list of papers.
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A31 - Sea Ice ❑

A32 - Snow ❑

A33 - Soil & Vegetation Biophysical Properties ❑

A34 - Soil Moisture & Roughness ❑

A35 - Sub-Surface Sensing ❑

A36 - Subsidences ❑

A37 - Urban & Country Planning ❑

A38 - Water Resources ❑

A39 - Remote Sensing Applications for Developing 
Countries 

❑

B01 - ADEOS2 ❑

B03 - CRYOSAT ❑

B07 - ENVISAT ❑

B08 - Global Change Observation Missions ❑

B09 - High Spatial Resolution & Commercial Imagery ❑

B11 - Instruments, Programs & Fields Experiments ❑

Click on title for a list of papers.
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B13 - JASON-1 & 2 ❑

B14 - NASA's Earth Observation System ❑

B15 - NPOESS ❑

B17 - RADARSAT-1 & 2 ❑

B18 - Micro- & Mini-Satellite Remote Sensing Missions ❑

B19 - SMOS ❑

B20 - SPOT-4 & 5 ❑

B21 - SRTM ❑

B22 - Surface, Satellite, or Airborne Missions ❑

B23 - TERRASAR ❑

B24 - ENVISAT/ASAR ❑

B25 - ENVISAT/Atmospheric Chemistry ❑

B26 - ENVISAT MERIS-AATSR ❑

B27 - In-Flight Altimeters ❑

B33 - TRMM & GPM ❑

C01 - Assimilation of Remote Sensing Data in Models ❑

Click on title for a list of papers.
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C02 - Atmospheric Processes & Dynamics ❑

C03 - Climatological Models & Climate Change ❑

C04 - Earth Radiation Budget ❑

C06 - Ecosystems ❑

C07 - Vegetation & Environmental Monitoring ❑

C08 - Geology & Geomorphology ❑

C09 - Hydrological cycle ❑

C10 - Ice Sheets ❑

C11 - Land Cover Change ❑

C12 - Land Surface Dynamics ❑

C13 - Ocean & Sea Ice Dynamics ❑

C14 - Soil Moisture & Hydrological Modeling ❑

C15 - Vegetation Growth ❑

D01 - Classification & Segmentation Algorithms ❑

D02 - Combined Optical & Microwave Analysis ❑

Click on title for a list of papers.
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D03 - Data Archiving, Retrieval, Standardization & 
Distribution 

❑

D04 - Data Assimilation ❑

D05 - Data Compression Techniques & Data Formats ❑

D06 - Data Correction & Calibration ❑

D07 - Data Fusion ❑

D08 - Data Mining ❑

D09 - Geographic Information Systems ❑

D10 - Hyperspectral Processing & Analysis ❑

D11 - Information Systems ❑

D12 - Interferometric Data Processing ❑

D13 - Inverse Problems ❑

D14 - Multi-Sensor Image Processing Techniques ❑

D15 - Optical Remote Sensing Methods ❑

D16 - Visualization & Interactive Analysis Techniques ❑

D17 - Optical Image Processing Techniques ❑

Click on title for a list of papers.

Main Menu



SessionsSessions
D18 - Polarimetric Data Processing ❑

D19 - Polarimetric Interferometric Data Processing ❑

D20 - Radar Image Processing Techniques ❑

D21 - Registration & Combination of Imagery ❑

D22 - SAR & 3D SAR Processing ❑

D24 - Change Detection Techniques ❑

E01 - Absorption, Emission, Refraction, Propagation & 
Scattering 

❑

E02 - Bistatic Remote Sensing ❑

E03 - Detection & Imaging of Buried or Camouflaged 
Objects 

❑

E04 - Electromagnetic Properties of Media ❑

E05 - Fast Numerical Algorithms & Techniques ❑

E06 - Near Grazing Angle Scattering ❑

E07 - Propagation Through Discrete & Continuous Random 
Media 

❑

E08 - Surface & Volume Scattering ❑

Click on title for a list of papers.
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F01 - Acoustic Systems ❑

F02 - Advanced Passive & Active Sensors ❑

F03 - Airborne Sensors ❑

F04 - Ground & Foliage Penetrating Radar ❑

F05 - HF Ocean Radar ❑

F06 - High Spatial Resolution Sensors ❑

F07 - Hyperspectral Remote Sensing ❑

F08 - Infrared Remote Sensing ❑

F09 - Instrument New Concepts ❑

F10 - Instrumentation & Future Technologies ❑

F11 - Interferometric & Differential Interferometric SAR ❑

F12 - Interferometric Radiometry ❑

F13 - Interferometric SAR Phase Information & Unwrapping ❑

F14 - Laser & Radar Altimetry ❑

F15 - Lidar Remote Sensing ❑

F16 - Microwave & Optical Polarimetry ❑

Click on title for a list of papers.
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F17 - Multi-Angular Optical Measurements ❑

F18 - Multi-Static Remote Sensing Systems ❑

F20 - Polarimetric Interferometry & Applications ❑

F21 - Radar Polarimetry & Applications ❑

F22 - Reconfigurable Future SAR Systems ❑

F23 - Remote Sensing Using GPS ❑

F24 - Remotely Piloted & Autonomous Vehicles ❑

F26 - Sensor Calibration & Image Quality ❑

F27 - Spectrometry / Radiometry ❑

F30 - Ultra Wideband Radars ❑

G01 - Innovations in RS Education ❑

G02 - Innovative Uses of The Internet ❑

G04 - International Frequency Allocations ❑

G07 - RS for Humanitarian Purposes ❑

G08 - RS for Management Decisions ❑

G09 - RS in Environmental Policy ❑

Click on title for a list of papers.
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G10 - Software & Data Sets for Education ❑

G12 - 2025 Earth Science Vision ❑

N01 - New Topics ❑

N02 - SIBERIA II ❑

Click on title for a list of papers.
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SMOS 

The Soil Moisture and Ocean Salinity Mission 
Y. Kerr, P. Waldteufel, J.-P. Wigneron, J. Font and M. Berger

❑

Monitoring Land Surface Soil Moisture from Multiangular 
SMOS Observations 
J.-P. Wigneron, P. Ferrazzoli, J.-C. Calvet, T. Pellarin, P. Waldteufel and Y. Kerr

❑

The Determination of Surface Salinity with SMOS - Recent 
Results and Main Issues 
J. Font, G. Lagerloef, D. Le Vine, A. Camps and O. Zanife

❑

Uncertainties on Salinity Retrieved from SMOS 
Measurements Over Global Ocean 
J. Boutin, P. Waldteufel, N. Martin, Y. Kerr, G. Caudal, E. Dinnat and J. Etcheto

❑

The SMOS End-to-End Performance Simulator: Description 
and Scientific Applications 
A. Camps, I. Corbella, M. Vall-llossera, N. Duffo, F. Marcos, F. Martínez-Fadrique and M. 
Greiner

❑

A Cardioid Model for Multi-Angular Radiometric 
Observations 
P. Waldteufel, J. Vergely and C. Cot

❑

Click on title to see the paper.
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Measurement of the Dielectric Constant of Seawater at L-
Band 
R. Lang, C. Utku and D. Le Vine

❑

Click on title to see the paper.
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ADEOS II 

Present Status of GCOM Mission 
H. Shimoda

❑

POLDER on ADEOS-2 
A. Lifermann and C. Proy

❑

ADEOS-II (Midori-II) Data System 
T. Takeshima, Y. Ishido, J. Inoue, S. Matsuoka, T. Takeba and N. Matsuura

❑

ADEOS-II Calibration and Validation Plan 
T. Igarashi and N. Matsuura

❑

Click on title to see the paper.
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Papers by SessionPapers by Session
25th Anniversary of the Seasat Launch - Seasat 
Legacy 

The Origin, Evolution and Legacy of SEASAT 
S. McCandless, Jr.

❑

Ocean Surface Wave Imaging from Seasat to Envisat 
W. Alpers

❑

Seasat Sees the Winds with SAR 
F. Monaldo

❑

Click on title to see the paper.
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Geographic Information Systems 

Spatial Decision Support System for Sediment Related 
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